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Chapter 1

Introduction

1.1 Background

This project is a part of the Toolbox component of the Australia-wide Assessment of River
Health, which is a sub-program of the Natural Heritage Trust’s National River Health Program.

The goal of the National River Health Program is to provide the information needed to reverse
the degradation of our inland waters. The objectives of the National River Health Program
are to:

1. Provide a sound information base on which to establish environmental flows;

2. Undertake a comprehensive assessment of the health of inland waters, identify key
areas for the maintenance of aquatic and riparian health and biodiversity, and identify
stressed inland waters;

3. Consolidate and apply techniques for improving the health of inland waters, particularly
those identified as stressed; and

4. Develop community, industry, and management expertise in sustainable water resources
management and raise awareness of environmental health issues and needs of our rivers.

The priorities of the Australia-wide Assessment of River Health include:

1. A nationwide assessment of 6000 sites using instream biota and habitat assessment; and

2. Development of a comprehensive toolbox of assessment methods for all inland waters.

An Australia-wide assessment of river health is continuing, under the National River Health
Program. This assessment uses a rapid, standardised approach for assessing riverine ecological
health, referred to as the Australian River Assessment Scheme (AUSRIVAS).

AUSRIVAS has two major modules, bioassessment and physical and chemical assess-
ment. The macroinvertebrate bioassessment component uses a series of models, which predict

1



Chapter 1. Introduction

the composition of the macroinvertebrate community at a river site in the absence of any im-
pacts. This data is then used to make a comparison with the macroinvertebrate community
actually found at a site. These models are based on data derived from 1500 reference sites
across Australia.

1.2 Selection and comparison of reference sites

A key issue with using AUSRIVAS models at the national and state level is reference site
condition reporting. Currently the models treat all reference sites equally. There are varia-
tions in the degree of human impact on reference sites within states, as well as between states,
which require an external framework for assigning a degree of comparison.

A systematic assessment of all rivers in Australia has already been carried out by the Wild
Rivers Project (Section 1.4). The Centre for Resource and Environmental Studies (CRES) at
the Australian National University has determined, at a national scale, the level of disturbances
for rivers on a continuum from pristine through to highly degraded.

The disturbance indices resulting from the Wild Rivers data set can be compared to reference
site AUSRIVAS scores, allowing development of a system for making comparisons between
reference sites in terms of the degree of human impact and then reporting them on a national
or regional level.

An added benefit of using the Wild Rivers data set is that it can also be used as an aid for
selecting new reference sites, on the basis of disturbance caused by human impact, which could
be a significant advancement on the existing system of reference site selection.

1.3 The role of the AUSRIVAS Mapping and Reference Site Screen-
ing module

The AUSRIVAS Mapping and Reference Site Screening module supplies the linkage between
AUSRIVAS outputs and the Wild Rivers river disturbance indices described above.

The module supplies river disturbance indices in a graphical map based format incorporating
sites, reference or otherwise, along with their associated AUSRIVAS outputs. In fact, the
software module has been made flexible to allow any extra site information to be included in
the outputs, not just the AUSRIVAS scores.

More detail about the AUSRIVAS Mapping and Reference Site Screening module software,
also referred to as the AUSRIVAS Mapping software, is presented in the following chapters,
starting with how the software works, and your system requirements to run it, in Chapter 2.

2



1.4 The Wild Rivers database

1.4 The Wild Rivers database

The Wild Rivers model produces indices of river disturbance using a grid-based GIS modelling
procedure. The Wild Rivers indices indicate the potential of a stream section to meet the
definition of a “Wild River”. Derived indicators are used to rate the level of disturbances for
stream sections on a continuum from pristine through to highly degraded.

The data base covers all natural water courses in the GEODATA TOPO-250K digital database
derived from 1:250000 map series. The level of detail available for different areas varies depend-
ing on the location, for example the level of detail about land uses, river systems for certain
areas such as Western Australia is limited. Thus, indices could be more accurately calculated
for some areas than others. Generally, with the exception of Western Australia, there is good
coverage of streams and land use across Australia.

1.4.1 Wild Rivers River Disturbance Index

The Wild Rivers index displayed in the maps of the AUSRIVAS Mapping software is the River
Disturbance Index (RDI). The RDI values span the range 0 to 1, with 0 being the most
pristine or “wild” and 1 being the most disturbed.

Within the 0-1 continuum, the RDI values are divided in bands or classes. The class divisions
originally applied to the Wild River indices for the purposes of viewing mapping outputs were
divided so as to differentiate between rivers at the undisturbed end of the continuum and
therefore identify any potential ’Wild Rivers ’. However, the class divisions implemented in the
AUSRIVAS Mapping software for each index have been altered and now are evenly distributed
along the continuum (0-1) of each index. This allows better differentiation at the upper end
(more disturbed) of the continuum and allows results to be compared across Australia. The
bands are shown in Table 1.1.

Table 1.1: Wild Rivers RDI bands

Band range Colour rendered on map Disturbance level
0.0 to less than 0.2 green Low disturbance
0.2 to less than 0.4 burgundy m0.4 to less than 0.6 purple
0.6 to less than 0.8 orange
0.8 to 1.0 khaki High disturbance

3



Chapter 2

Installation and setup

2.1 System requirements

2.1.1 Software requirements

The AUSRIVAS Mapping software runs under Microsoft Windows. It has been tested un-
der Windows NT, Windows 2000 and Windows XP. Unfortunately, versions of the Mapping
software for operating systems other than Microsoft Windows are not available.

2.1.2 Hardware requirements

• IBM compatible PC.

• Network access, either direct or through a proxy server.

• The minimum recommended memory required to run your version of Microsoft windows.

2.2 How to get the software

The software can be obtained from the AUSRIVAS website

http://ausrivas.canberra.edu.au

Navigate from the main page, using the left-hand menu to the section ”Mapping and reference
site screening module” (under “Resources”). From here select “Get the Mapping & Reference
Site Screening software” from the left hand menu. On the “Get the software” page you will
find information on the four-step process for downloading and using the software.
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2.3 Access requirements

Step 1 Details access requirements (see Section 2.3). There are no restrictions on downloading
AUSRIVAS software. However, to run the program you need to obtain a username and
password. This is explained further in Section 2.3.

Step 2 Involves downloading the software. Simply click on the link given in this section and
you will be prompted for the location where you’d like to save the software.

Step 3 Shows you how to install the software. This information is also given here in Sec-
tion 2.4.

Step 4 Gives links this document and others which show you how to use the software

2.3 Access requirements

To use AUSRIVAS software, you need to have a username and password.

To obtain these access codes, you must apply through your State or Territory National River
Health Program (NRHP) contact. An up-to-date list of NRHP contacts is maintained on the
AUSRIVAS web site, (select “NRHP contacts” from the left hand menu).

Note: If you already have an AUSRIVAS password (for accessing the models) you don’t need
to get another one.

2.4 How to install the software

Once you have downloaded a copy of the AUSRIVAS Mapping and Reference Site Screening
Module Software (Section 2.2), you can begin to install it on your computer. The following
steps take you through the process of installing the software.

2.4.1 Download the installation program

Firstly, note the name and type of file you have downloaded. The name will show you the
version number of the software you are about to install. For example, the file:

Ausrivas MappingSetup 1-0.exe

shows you that you have the Mapping and Reference Site Screening Software (Mapping) Version
1.0 (the file you obtain may have a different version number depending on further development).
Also, the file you download is not the program. It is an installation program that when run,
will install the Mapping software on your computer and set up menu’s and desktop icons to
run the software.

More on this later in this section.
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Chapter 2. Installation and setup

2.4.2 Uninstall old versions

Before you start to install a new version of the AUSRIVAS Mapping and Reference Site Screen-
ing Software, you should uninstall any older versions if you have them. You do this using
“Add/Remove programs” from the Control Panel.

2.4.3 Install the mapping software

The file you have downloaded, Ausrivas MappingSetup 1-0.exe, is an installation file. To
start installation of the Mapping software, double-click on the filename in Windows
Explorer or My Computer. The steps involved in this part of the installation are detailed
next.

1. The setup program will initially spend some time setting up files on your computer for
the install. When this is finished, it will present you with a welcome screen as shown
in Figure 2.1. If you don’t currently have the Mapping software installed, you will be
prompted to click on the ’Next’ button to proceed with installation. If however you have
the Mapping software already installed, clicking on ’Next’ will allow you to modify, repair
or uninstall the Mapping software.

Figure 2.1: Installation program - Welcome screen

2. The next screen shows the licence agreement for the AUSRIVAS Mapping software, as
shown in Figure 2.2. Scroll down using the scrollbar on the right to view the entire
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2.4 How to install the software

agreement. You must agree to the licence conditions to continue the software installation.
To signal your agreement, click on the radio button labelled “I accept the terms of the
license agreement”, then click on the ’Next’ button to continue installation.

Hint: If the ’Next’ button is greyed out, click on “I accept the terms of the license
agreement”.

Figure 2.2: Installation program - License agreement

3. Enter your name and organisation in the customer information screen, shown in Fig-
ure 2.3. Click ’Next’ to continue.

Figure 2.3: Installation program - Customer information
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Chapter 2. Installation and setup

4. The following screen allows to you select the destination folder that the program will
be installed in. If you wish to accept the default, shown in Figure 2.4 as C:\Program
Files\AUSRIVAS\AUSRIVAS Mapping Client just click on ’Next’. If you want to change
the destination folder from the default setting, click the ’Change’ button and navigate to
the destination folder in the ’Change Current Destination Folder’ dialog that appears, as
shown in Figure 2.5. Click on ’OK’ to continue.

Figure 2.4: Installation program - Destination folder

Figure 2.5: Installation program - Change destination folder

5. The confirmation screen shown in Figure 2.6 shows you the installation options you have
chosen. If you wish to change any of the settings, click on the ’Back’ button. Otherwise
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2.4 How to install the software

select ’Install’ to begin installation of the AUSRIVAS Mapping software.

Note: This is the last chance you have to cancel installation if you wish to do so. Clicking
on ’Install’ will cause installation to commence and you will not be prompted again until
installation has completed.

Figure 2.6: Installation program - Confirm installation

6. When installation has successfully completed, the ’Installshield Wizard Completed’ screen
will be shown. Clicking on ’Finish’ will end the installation process and start up the
AUSRIVAS Mapping software. If you don’t want the Mapping software to start up now,
deselect ’Launch the program’ by clicking on the tick-box.

Figure 2.7: Installation program - Installation completed
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You have now installed the AUSRIVAS Mapping and Reference Site Screening Software! The
next section shows you how to start up the software.

HINT: If you have any problems first talk to your systems administrator - most problems
fall under her or his domain. If your systems administrator believes the problem to
originate with the AUSRIVAS program, refer to our help page on the AUSRIVAS web
site for the name of someone to contact at the CRCFE.

2.4.4 Start the program

The installation program has set up two ways for you to start the AUSRIVAS Mapping program.

1. A menu item has been set up for you in the Start Menu. Open the Start menu, select
’Program Files’ and then ’AUSRIVAS’ and click on the program name ’AUSRIVAS Map-
ping & Reference Site Screening Module’ to launch the AUSRIVAS Mapping program.
This is shown in Figure 2.8.

Figure 2.8: Installation program - Start menu item

2. A shortcut icon has also been added to your desktop, which will look like the one shown
in Figure 2.9. To start the AUSRIVAS Mapping program, double-click on the desktop
icon.

2.5 How Internet access works

The AUSRIVAS Mapping software requires Internet access to run, in much the same way as
the AUSRIVAS Macroinvertebrate Predictive Modelling software and the AUSRIVAS Physical
& Chemical Reporting software does. Figure 2.10 illustrates how this works.
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2.5 How Internet access works

Figure 2.9: Installation program - Desktop shortcut

Figure 2.10: How Internet access works
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All the 1:250K streamline and WildRivers data used by the program is stored on the AUSRIVAS
map server, which is currently located in Canberra at the CRC for Freshwater Ecology. So
when you - the user - request a map, Internet access for communication between your machine
and the AUSRIVAS map server is required.

2.5.1 Why is the map data stored on a server?

Part of the data used by the AUSRIVAS Mapping software to create a map is the AUSLIG
1:250K streamline data, which is not publicly available unless you pay a licence fee. In order
to allow users of the AUSRIVAS Mapping software to access streamline information without
having to purchasing a licence, an agreement was made between LAWA, the CRCFE and
AUSLIG.

This agreement allows AUSRIVAS Mapping Software users to obtain images created from the
streamline data but does not allow users access to the ’raw’ streamline data. By keeping the
streamline data on a central server rather than distributing it with the software, we are able
to partially fulfil this condition. The AUSLIG streamline data are also protected by password
access and by user agreement (when you install the software you need to agree to a set of
conditions about using the streamline data), which together with the method of keeping the
data on a central server, fully meet our obligations in regards to protecting the streamline data.

2.5.2 What happens to my site data?

The site data that you load into the Mapping Software is secure as it does not leave your
machine. The only information sent from your machine to the AUSRIVAS map server is;

1. Information to enable the server to send you the correct map area, such as the coordinates
of a rectangle bounding your sites.

2. The type of map you want, either a fully functional map which allows you to zoom, move
sites, query map features etc (a large file) or a map which is only suitable for printing (a
smaller file). NOTE: the second option of requesting a map only for printing is not yet
available.

2.6 Setting up the software for Internet access

2.6.1 How do I enter my AUSRIVAS password

When you run the AUSRIVAS software, you will need to enter your AUSRIVAS username and
password. While the program is open, it will store the username and password you give it, so
you only need to enter this information once each time you run the software.

12



2.6 Setting up the software for Internet access

You must enter your AUSRIVAS username and AUSRIVAS password
BEFORE YOU REQUEST A MAP

The steps for entering your AUSRIVAS username and password are:

1. Open the Properties dialog box, which can be found under the Edit menu as shown in
Figure 2.11.

Figure 2.11: Opening the Properties dialog from the Edit menu.

2. Click on the Map Server tab. This will display the window where you can enter your
password details, as shown in Figure 2.12.

3. Type in your AUSRIVAS username (shown as “myAUSRIVASusername” in Figure 2.12)
and your AUSRIVAS password (shown as ∗’s in Figure 2.12).

4. Click on the OK button.
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Figure 2.12: Entering your AUSRIVAS username and password.

Your AUSRIVAS username and password are provided to you by the
AUSRIVAS server administrators, currently the CRC for Freshwater Ecology at

the University of Canberra. For further information on AUSRIVAS usernames and
passwords, see Section 2.3.

2.6.2 What if I access the Internet through a proxy server?

The AUSRIVAS Mapping Software allows you to access the AUSRIVAS server through a proxy
server. It also allows you to enter a username and password for your proxy server if it requires
this (proxy authentication).

Before you can use the program to obtain data via the Internet, you need to give it details
about your proxy server. The information you need, which can be obtained from your Systems
Administrator, is:

1. Your proxy server’s name. For example, we at the University of Canberra need to enter:

proxyhost.canberra.edu.au

2. The port number your proxy server uses for HTTP connections. This is usually port
80.
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2.6 Setting up the software for Internet access

You must enter your proxy server name and proxy server port number
BEFORE YOU REQUEST A MAP

The steps for entering your proxy server details are:

1. Open the Properties dialog box, which can be found under the Edit menu (see Fig-
ure 2.11).

2. Click on the Proxy Server tab. This will display the window where you can enter your
proxy server details, as shown in Figure 2.13.

3. Type in your proxy server’s name (shown as “myproxyhost.mydomain.au” in Figure 2.13)
and your proxy port number (shown as “80” in Figure 2.13).

4. Click on the OK button to store these settings.

Figure 2.13: Setting proxy hostname and port

Once you have entered your proxy server details, the AUSRIVAS Mapping Software will be
able to access data on the AUSRIVAS map server via the Internet.

2.6.3 My proxy server requires a password

It is common for proxy server’s to require authentication in the form of a username and
password. This is known as ’proxy authentication’ If this is the case at your site, you can
enter your access codes using the Properties dialog.
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You must enter your proxy username and proxy password
BEFORE YOU REQUEST A MAP

The steps for entering your proxy server authentication details are:

1. Open the Properties dialog box, which can be found under the Edit menu.

2. Click on the Proxy Server tab. This will display the window where you can enter your
proxy server details.

3. Select Proxy authentication required by clicking in the check box, as shown in Fig-
ure 2.14. The check box should now have a tick mark in it.

4. Type in your proxy username (shown as “myproxyusername” in Figure 2.14) and your
proxy password (shown as ∗’s in Figure 2.14).

5. Click on the OK button to store these settings.

Figure 2.14: Setting proxy username and password

As with server authentication (your AUSRIVAS username and password) you only have to
enter this information once each session.

The username and password required by your proxy server (proxy
authentication) are access codes provided to you by your Systems Administrator.

They are NOT your AUSRIVAS username and password.
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2.6.4 Setting the Internet timeout

There is a setting in the AUSRIVAS mapping program that determines how long the program
will wait for a map to be generated and sent over the Internet to your machine. By default,
this timeout value is set to four hours - a figure that is calculated for the biggest map the
server will let you request. If you want to change this value, either to reduce it, or to increase
it if you want to request a large map and have a slow Internet connection, you can via the
Map server tab in the Properties dialog, as shown in Figure 2.12.

NOTE: The time it takes to get a map in the AUSRIVAS mapping program is normally in
the order of minutes, rather than hours! More information on how long it takes to get a map,
and the steps involved in creating a map can be found in Section 4.2.

2.7 Setting a temporary directory

The AUSRIVAS Mapping software needs to create temporary files while it runs. You can set
the folder that the software will put these temporary files in the Properties dialog. This is
shown in Figure 2.15.

By default, the temporary files path is set to C:\temp. You can change this once the program
starts, and your new settings will be saved so you don’t need to re-enter them next time you
run the Mapping software.

If for some reason the set temporary directory is not valid (for example, it doesn’t exist, isn’t
writeable etc) you will be prompted to either supply a new path for the temporary directory
or exit the program (cruel but necessary!).

Figure 2.15: Setting a temporary directory
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2.8 Saving my customised program settings

If you have set or changed settings in the AUSRIVAS Mapping software, in most cases you
won’t need to re-enter them next time you use the software.

Several settings are stored in Window’s registry, and whenever you run the software, these
settings will be loaded for you.

The settings that are stored between program uses are shown in Table 2.1:

Table 2.1: Program settings that will be saved between program runs.

Saved program settings
Proxy server name
Proxy server port
AUSRIVAS username
Proxy server username
Temporary directory

To change the settings saved in the registry, simply change them within the program, and when
the program ends it will replace the old settings with your new ones.
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Setting up site data

3.1 What are site data?

The site data are the spatial (geographic) information about sites along with any extra site
data you want displayed with your map.

The AUSRIVAS Mapping software will display these site on a streamline map along with their
corresponding emph Wild River River Disturbance Index.

3.2 How to set up a site data set

3.2.1 Obtain the spatial information about your sites

For each site that you want included in your map, you need to obtain the site’s spatial coordi-
nates. The specifications for these coordinates are:

Reference system: Geographic (latitude and longitude)
Datum: WGS84
Prime Meridian: Greenwich
Co-ordinates: Decimal degrees

The AUSRIVAS Mapping software doesn’t enforce a minimum degree of accuracy in your
coordinate values, however we recommend using a minimum of 4 decimal places which will give
you an accuracy of ±10m. If you can enter your site coordinates to 5 decimal places you will
decrease error to around 1m.
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3.2.2 Obtain other desired information about your sites

Along with spatial information about your site, you can include other information in your site
file. This information will be included in your map as a feature attribute of each site.

Some ideas for extra fields include:

• AUSRIVAS O/E bands.

• Site coordinates, if they are normally kept in a format different from the one used here
(ie eastings and northings).

• Comments about the type of site ie reference site, test site.

3.2.3 Allocate site codes

Each site in your site file must be referred to by a site code. This code is alphanumeric, and
so can contain digits or characters or both. Some examples of valid site codes are shown in
Table 3.1. Note that, as shown in these examples, numeric site codes must be enclosed
in quotes.

The site codes in one site file can each be in any of these formats. So for example, your first
site code could be numeric, while the second contains only alphabet characters and the third
is alphanumeric.

Table 3.1: Examples of valid site codes.

Type Site code
numeric “4106789”
alpha-numeric AM436
alpha Molonglo
alpha with spaces Molonglo upstream of dam

3.2.4 Set up the site data in CSV format

Once you’ve determined the spatial information for your sites, you can assemble the data into
a site data file.

The site data file is in comma-separated values (CSV) format. Data are arranged in rows and
columns, with one row for each site. The first row of the file contains labels, or headings, for
each column.

Data have the following general properties:

• The data for a site occupies one row.
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3.2 How to set up a site data set

• Each row must have the same number of data. For example, if site 1 has 5 attributes,
all other sites must have five attributes.

• Three columns are compulsory. These contain a site code and the latitude and longi-
tude of the site. If one or more of these required fields is not present the program will
generate an error.

• Each column must have a heading. The acronyms of the headings for the three compulsory
columns must be as specified below.

• The columns of data not specified above can have any acronym for their column heading.

Each column of data contains a different type of information. The layout of information
required in each column is:

Column 1 contains the site code. This column must be labelled LOCATION C.

Column 2 contains the latitude of the site. This column must be labelled LATITUDE.

Column 3 contains the longitude of the site. This column must be labelled LONGITUDE.

Columns 4 to n (where n is the number of columns) contain any extra data that you would
like included as an attribute of the sites on the map. Some ideas for extra fields are
shown in Section 3.2.2.

If you use NUMERIC site codes, the site code MUST BE ENCLOSED IN
QUOTES, as shown in Table 3.1.

An example site file is shown below in Table 3.2. This file has the three compulsory columns,
sitecode, latitude and longitude, along with extra optional data: site type, easting, northing,
O/E taxa score and taxa band.

Table 3.2: Example site file

LOCATION C,LATITUDE,LONGITUDE,SITETYPE,EASTING,NORTHING,O E TAXA,TAXA BAND
‘‘4102001’’,-35.3291596,148.9473896,Reference,677000,6088700,0.96,A
‘‘4102002’’,-35.3220563,148.9406193,Reference,676400,6089500,0.88,A
‘‘4102003’’,-35.3481086,148.8895263,Reference,671700,6086700,0.95,A
‘‘4102005’’,-35.4174656,148.8349786,Reference,666600,6079100,1.11,A
‘‘4102006’’,-35.6123930,148.8217576,Reference,665000,6057500,1.18,X
‘‘4102007’’,-35.3423032,148.9146972,Reference,674000,6087300,0.97,A
‘‘4102008’’,-35.3223664,148.8636270,Reference,669400,6089600,0.91,A
‘‘4102009’’,-35.3605884,148.8402936,Reference,667200,6085400,1,A
‘‘4102010’’,-35.3678742,148.9505206,Reference,677200,6084400,0.96,A
‘‘4102012’’,-35.4155286,148.9582763,Reference,677800,6079100,0.97,A
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Tools for creating a CSV file

A convenient method for creating CSV files is to set up your data first in a spreadsheet. In the
spreadsheet each cell will contain an item of data as shown in Table 3.3.

Table 3.3: Example of setting up site data in a spreadsheet.

LOCATION C LATITUDE LONGITUDE SITETYPE EASTING . . .
4102001 -35.32915 148.94738 Reference 677000 . . .
4102002 -35.32205 148.94061 Reference 676400 . . .
...

...
...

When you have set up the data in the spreadsheet, use the “Export” or “Save As” option to
save the data as a CSV file, choosing the comma as the column (or data) delimiter.
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Getting a map

Start the AUSRIVAS Mapping program, as described in Section 2.4.4. When you first start the
AUSRIVAS Mapping software, the program window will look like the one shown in Figure 4.1.
A description of the different components of the program window is given in Section 5.1.

Figure 4.1: AUSRIVAS Mapping program window at startup.

Once you have set up the program (as explained in Section 2) and created a site data set
(Section 3), you are ready to create a map!
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The steps for doing this are detailed in the following sections, starting with loading your site
data.

4.1 Loading site data

There are two ways you can start the process of loading your site data. Either select Open

from the File menu as shown in Figure 4.2, or click on the open icon in the toolbar.

Figure 4.2: Opening a site file using the menu.

Selecting the Open menu item or toolbar icon will cause the Open dialog box to be dis-
played. The Open dialog box is shown in Figure 4.3. Simply navigate to the folder your
site data is stored in, and select the site file name by clicking on it. In Figure 4.3 the file
100x100sites latlong.csv has been selected.

When you now click on the Open button the AUSRIVAS Mapping software will start to load
your site data file. While the program is in the process of opening your site file and plotting
your site data, it will inform you of its progress in the information bar at the bottom of the
program window. An screen shot of the status message displayed as your site data is being
loaded is shown in Figure 4.4.
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4.1 Loading site data

Figure 4.3: Open Site File dialog box.

Figure 4.4: Status message showing that site data is being loaded.

25



Chapter 4. Getting a map

When the program has finished loading and plotting your site data, it will inform you with a
status message “finished” as shown in Figure 4.5.

Figure 4.5: Status message showing that site data has been loaded.

Your AUSRIVAS Mapping software window will now look something like Figure 4.6. Your sites
have been plotted according to the coordinate system specified in Section 3.2.1, and a scalebar
is shown under the map. A north arrow has been added (where the AUSRIVAS logo used to
be), and a map title is displayed.

4.2 Requesting a map

When your site data is loaded, you can request a map from the AUSRIVAS map server.

To do this, open the Map menu, select Get map and then select Full capabilities from the
second menu that pops up. This is shown in Figure 4.7. The other option in this second menu
For printing only is greyed out as it has not been implemented yet. In future versions of the
Mapping software you will be able to download either a large file that contains a map with all
(“full”) capabilities, or a smaller file that contains a rasterised map that can be printed but is
without the extra capabilities of the larger map such as zooming, querying and moving sites
(these are described in later sections).
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Figure 4.6: AUSRIVAS Mapping program window with site data loaded.
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Figure 4.7: Requesting a map using the menu.
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4.2 Requesting a map

Once you have requested a map from the AUSRIVAS map server, the status bar at the bottom
of the program window will let you know the progress of your map. There are four main stages
in getting your map.

Stage 1: Creating the map on the AUSRIVAS Map Server

The first stage is creating the map on the AUSRIVAS Map Server. This can take some time,
and the time to create your map increases with the size of the map. As an example, a map
whose boundaries are within 1 map sheet will take around 5 seconds to produce, however one
that spans 20 map sheets can take around 15 minutes.

In order to make the operation of the map server viable, a TIME LIMIT OF 60
MINUTES is applied to the creation of maps. If your map takes longer that one

hour to produce, you will get an error message ’Internal server error’.

Stage 2: The map is sent to your machine over the internet

Once the AUSRIVAS map server has created your map, the second stage commences, where
the map is sent to your machine over the internet. The time taken to do this depends
on the speed of your connection and also on the size of the map. You can expect a file size of
around 6MB for a map that is as big as one full 250K map sheet, which will take around
10-60 seconds to transmit over a standard ethernet connection. A 20 sheet map might be
around 140MB compressed, so will take upward of 3 minutes (possibly up to 30 minutes) to
transmit. If you are accessing the data through a modem, the time taken will be even longer.
As an example, if you have a 56K modem, the files listed above could take up to 200 times
longer to download than the times given for an ethernet connection.

So the lesson here is ... be aware of the size of the map you are requesting and tailor
your input data to make sure that the map you are requesting is not too big.

The maximum time that the Mapping program will wait for a map to be both
created and downloaded to your computer is set by default to FOUR

HOURS. If you need more time than this, adjust the timeout setting following
the method described in Section 2.6.4.

Stage 3: The RDI of your sites is determined

Once the map data has been downloaded to your machine, each site in your input data is
’matched’ to a streamline on the map in order to determine the RDI of your site. This matching
involves searching all of the streamlines in the map for the one that is closest to your site. So,
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as in the previous steps, the size of your map will determine the amount of time that this
takes. A map that spans less than 1 map sheet and/or has few streamlines can be searched
very quickly in a matter of seconds. Increasing the size and density of the map will result in
increased searching times. For example, a map spanning 20 map sheets (all of Queensland)
took around 40 seconds to search per site on a 200MHz desktop machine. The site data for
this run contained 800 sites, so this stage of running the program took over 8 hours! There is
nothing wrong with doing this as long as you are willing to wait the time it takes.

Stage 4: The map is plotted

When your AUSRIVAS Mapping software has received the map from the AUSRIVAS map
server and determined the RDI of your sites, the map is plotted in the map window of the
program. This involves, among other things, some rendering of the streamlines and setting of
coordinate systems, which can take several seconds, depending on the speed of your machine.

Figure 4.8 shows one of the status messages you’ll see as your map is created, sent and displayed.

Figure 4.8: Status bar showing map display message.

30



4.2 Requesting a map

4.2.1 What area will my map cover?

The AUSRIVAS Mapping software calculates the boundary of your map using the extreme
values of latitude and longitude from your site data and adding a buffer to these.

The buffer is calculated at 10% in each direction (ie 10% of longitude in the x direction and
10% of latitude in the y direction). If all of your sites are on the same latitude, then the latitude
buffer is calculated as latitude buffer=longitude buffer×90÷ 360. Alternately, if all your sites
are on same longitude, the longitude buffer is set to latitude buffer×360÷ 90

In the extreme case of all your site/s being at the same latitude and longitude (ie you are
plotting only one site) the map boundary around your site will be set to 1

4 decimal degree.

The area of your map determines how big the map file sent from the AUSRIVAS map server
will be and how long it takes to arrive at your machine and display, as discussed in the previous
section. It is suggested that you check the area your sites cover before you request a map.
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Interpreting the map

5.1 Description of the map

The AUSRIVAS Mapping program window is shown in Figure 5.1. Each component of the
program window is labelled for reference in the following sections that explain some methods
of displaying and querying map features.

Figure 5.1: Elements of the AUSRIVAS Mapping program
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5.2 Displaying map features

The map view part of the program window is shown in Figure 5.1 labelled “Map”. This example
has a map displayed, which is composed of site data (circles) and streamlines colour-coded to
indicate Wild River RDI band.

Currently these are the only features shown on the map produced by the AUSRIVAS map
server, however it is possible that in the future, each map could be layered with topographic
data allowing identification of roads and other infrastructure which may be useful for spatial
location or determining possible impacts on sites.

5.1.1 Terminology

Some terminology used in this and following sections of the AUSRIVAS Mapping software
manual is explained in this section.

Map view A collection of geographic features displayed in the Map area of the program
window.

Feature A geographic component of the map, for example, sites, rivers or lakes.

Legend The legend shows the symbols used to draw the streamline features.

Streamlines The river features on a map.

Attribute Information about the features in a map. For example, River Disturbance Index
is an attribute of the streamlines.

Global extent The whole map.

5.2 Displaying map features

This section explains how to obtain information from the map.

5.2.1 Displaying a feature’s attributes

Each geographic feature in the map has information associated with it that you can access.
The attributes of your sites consist of the extra fields you entered into your site data file
(Section 3.2.2). Each streamline segment has the attributes shown in table 5.1

The method of accessing a features attributes is shown in Figure 5.2.

Select the information tool by clicking on its icon in the toolbar. When the information

tool is selected, the cursor will change to an arrow with an ’i’ above it, , when it is over

the map.
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Table 5.1: Attributes of the streamline data

Attribute Description
Length The length of the streamline segment
Name The river name
RDI The River Disturbance Index
ID A map feature ID
Map The map sheet that the data falls within

To use the information tool, position the cursor over the feature whose attributes you want
to view and click the left-hand mouse button. When you click on Site 4102232 as shown in
Figure 5.2, you get the attributes dialog shown first in Figure 5.3

Figure 5.2: Using the Information Tool to view a sites attributes.

The information tool searches for map features that are within a predefined radius (based
on a percentage of the map view area) and will find all the features within its search radius.
This can be shown by moving the cursor south, and requesting information from the position
where three streamlines intersect (just below Site 4102233) as shown in Figure 5.4.

In this case three features are found, and the first one, listed by feature ID, is shown in the
second dialog box in Figure 5.3. You can view the attributes of the other two features simply
by selecting them from the drop-down list at the top of the dialog.
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Figure 5.3: Looking at attributes of map features
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Figure 5.4: Using the Information Tool to view streamline attributes.
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5.2.2 Displaying the Wild Rivers RDI’s

Each site displayed on your map is colour-coded to represent the Wild Rivers RDI band it
belongs to.

You can also choose to render the streamlines in your map based on the Wild Rivers RDI.

Sites

The sites on your map are colour-coded with a Wild Rivers RDI band as per the colours
described in Table 1.1.

The RDI for each site is found by searching for the nearest streamline to the site that is within
500m. If no streamlines are found within 500m, the site is coloured black. If one or more
streamlines are found within 500m, the one that is closed to the site is located and it’s RDI
applied to that site.

If your site is located on the wrong streamline and hence allocated an incorrect RDI you can
move the site as described in Section 6.3

Streamlines

To render the streamlines based on RDI band (a different colour is displayed for each band):

1. Open the Format map dialog from the Map menu as shown in Figure 5.5.

2. In the view tab of the Format map dialog, make sure River annotations is checked,
then select Wild Rivers RDI’s from the two river annotations available. (see Figure 5.6)

3. Click OK

A map with the streamlines rendered with colour-coded RDI values is shown in Figure 5.7.

5.2.3 Displaying river names

If you instead want to display river names on your map, open the Format map dialog using
the method explained in Section 5.2.2. Make sure River annotations is checked, then select
River names from the river annotations available as shown in Figure 5.8.

A map rendered with the river names renderer is shown in Figure 5.9. The river names renderer
only shows river names if there is room to display them without overlapping other river names.
This means that you may have to zoom in (as in this example) before you can see the labelled
rivers. To find out how to zoom, see Section 6.1.
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Figure 5.5: Opening the Format Map dialog.

Figure 5.6: Selecting the Wild Rivers RDI renderer.
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5.2 Displaying map features

Figure 5.7: Map with streamlines rendered using the Wild Rivers RDI bands.

Figure 5.8: Selecting the river names renderer.
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Figure 5.9: Map with streamlines rendered using the river names renderer.
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5.2 Displaying map features

5.2.4 Displaying streamlines only

To display streamlines without any rendering,

1. Open the Format map dialog from the Map menu as shown in Figure 5.5.

2. In the view tab of the Format map dialog, make sure River annotations is not
checked as in Figure 5.10 (you can un-check by clicking with the mouse).

3. Click OK

Figure 5.10: Removing all streamline renderers.

5.2.5 Displaying site codes

As well as selecting a renderer for the river features on your map, you can choose to label your
sites with the site code you entered into the site file.

To do this, open the Format map dialog as explained in Section 5.2.2, and check the Site
names box near the bottom of the dialog, as shown in Figure 5.11, then click on OK.

An example of labelled sites, combined with the Wild Rivers RDI streamline renderer, is shown
in Figure 5.12.

Unlike the river names renderer, site names are all displayed even if they overlap each other.
This means that you probably won’t want to use this option if you have more than around ten
sites on your map.
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Figure 5.11: Choosing to displaying site codes on the map.

Figure 5.12: Map with sites labelled with site code.
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Working with a map

6.1 Panning and zooming

The maps produced require panning and zooming capabilities to allow you, the user, to inter-
rogate the maps at a variety of spatial scales.

The available methods of panning and zooming are illustrated in the following sections.

6.1.1 Panning

The pan tool lets you change the area of the map that you are viewing by dragging the display
in any direction with the mouse.

Enable the pan tool by selecting the pan icon on the program toolbar, as shown in
Figure 6.1. You can then click on the map and holding the mouse button down, drag the map
left, right, up or down, to display a new area of the map in the map window.

You can also enable the panning tool from the View menu as illustrated in Figure 6.2

6.1.2 Zooming

Zooming using the zoom-in tool

To enable the zoom-in tool click on the zoom-in icon on the program toolbar, as shown
in Figure 6.3. There are two methods of using the zoom-in tool, as described below.

1. To zoom in by a factor of one half, centred on a particular position on the
map view, click that position once (with the zoom-in tool enabled).
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Figure 6.1: Enabling the Panning tool using the toolbar.
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6.1 Panning and zooming

Figure 6.2: Enabling the Panning tool using the menu.
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Figure 6.3: Enabling the Zoom In tool.
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6.1 Panning and zooming

2. To zoom to a particular area of the view, drag out a box over this area with the
mouse.

This second method, of zooming by dragging out a rectangle, is illustrated in Figure 6.4

Figure 6.4: Using the mouse to zoom in.

Zooming using the zoom-out tool

To enable the zoom-out tool click on the zoom-out icon on the program toolbar, as
shown in Figure 6.5.

The zoom-out tool works in the same way as the zoom-in tool but zooms out by a factor of 2
from the position you click or the area you drag over.

Zooming to a percentage of the global extent

You can zoom to a proportion of the global extent using the View / Zoom menu as shown
in Figure 6.6. This differs from the zoom-in and zoom-out tools which zoom to a scale factor
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Figure 6.5: Enabling the Zoom Out tool using the toolbar.
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6.2 Locating a site

of the current map extent rather than the global map extent. The map extent resulting from
zooming to a percentage of the global extent is always centred at the centre of the map.

Figure 6.6: Zooming to a proportion of the global extent

The Global Extent

You can show the global (full) extent of your map at any time by clicking on the Global

extent icon on the toolbar.

6.2 Locating a site

You can use the site search tool to find a site in your map. The search is based on the name
attribute of your site features (ie the data in your site file headed “LOCATION C”).

To locate a site, type its name into the text input box at the bottom left corner of the AUS-
RIVAS Mapping program window, and hit the ENTER key.

The AUSRIVAS Mapping program will then search for the site you have named, and if it finds
the site it highlights it on the map by flashing the site three times. This is shown in Figure 6.7,
where the site named 4102231 was found.

If the feature that is found is not in the map’s current view, the map extent will automatically
be altered so that the highlighted feature is in the centre of the view.

6.3 Moving a site

You, as the software user, are required to supply locations for your sites (latitude and longitude
in decimal degrees with five decimal places) to ensure reasonably accurate location of sites.

You will still need to crosscheck sites to ensure that sites are placed within the appropriate sub-
catchment and thus, will have the appropriate Wild Rivers River Disturbance indices assigned
to them.
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Figure 6.7: Locating a site.
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6.3 Moving a site

To move a site that has been incorrectly located on the map, use the move tool as shown in
Figure 6.8.

Figure 6.8: Enabling the move tool.

While the move tool is enabled, the cursor will be shown as crosshairs, +, while it is over the
map. To move a site, simply click on it with the mouse and while holding the mouse button
down, drag the site to a new location.

The program window, shown below in Figure 6.9, shows the map we have been working with
(Figures 6.7 and 6.4) after Site 4102232 has been moved. Its new location is on a different
stream segment with a different RDI, hence the colour of the site has changed from burgundy
(RDI between 0.2 and 0.4) to green (RDI between 0 and 0.2).

Having a look now at the attributes of Site 4102232 (the site we’ve just moved) you can see
that, as well as the site’s RDI being changed, the latitude and longitude have been updated to
reflect the site’s new location (Figure 6.10). Section 7.1 explains how to save this updated site
data.

Also looking at the attributes for the streamline that Site 4102232 is now on (the second
window in Figure 6.10) you can see that the Wild Rivers RDI for this site is now 0.185, where
previously it was 0.2 (Figure 5.3).
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Figure 6.9: Map showing the new location of moved site, Site 4102232.

52



6.3 Moving a site

Figure 6.10: Attributes of site and river features.
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To CANCEL OR ABORT MOVING A SITE once you have started
dragging it, drag it completely outside the map view. Once you ’let go’ of the site

by releasing the mouse button, it will return to its original location.

6.4 Setting map colours

Not yet implemented.

6.5 Displaying information on the map

You can choose to change the information that is displayed on the map, or display extra
information. When the program starts, by default a map will show:

• Sites (displayed as a circle);

• Streamlines colour coded according to RDI band.

You can add to the information shown by displaying site codes alongside each site (Sec-
tion 5.2.5).

You can change the information shown by displaying river names beside streamlines instead
of colour coding the streamlines according to RDI band. (Section 5.2.3)

6.6 Changing the screen layout

As well as changing the appearance of the map, you can also change the layout of the program
screen. By default the program window will show (once a map has been loaded):

• the map;

• a map title, created using the name of your site data file;

• a legend, describing how the streamlines are displayed;

• a scalebar;

• a north arrow;

• an information bar.

You can choose to change or hide several of these components, as described in the following
sections.
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6.6 Changing the screen layout

6.6.1 Title

Displaying a map title

To display the map title:

1. Open the Format map dialog box by selecting Format from the Map menu as shown
in Figure 6.11.

Figure 6.11: Opening the Format Map dialog box.

2. Check the Map title checkbox at the top of the dialog (shown in Figure 6.12).

3. Click on the OK button

Hiding the map title

Hiding the map title allows for a bigger map area on your program window. This is shown in
Figure 6.13 - this program window also has the legend hidden (Section 6.6.2).
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Figure 6.12: Displaying the map title

1. Open the Format map dialog box by selecting Format from the Map menu as shown
in Figure 6.11.

2. Click on the Map title checkbox at the top of the dialog to remove the tick-mark from
the box.

3. Click on the OK button

Changing the map title

When you first open a site file, a map title will be automatically generated from the name of
the site file. For example if your site file is called “my sites.csv” the map title will be set to
“my sites”.

To set or change the map title:

1. Open the Format map dialog box by selecting Format from the Map menu.

2. Check the Map title checkbox at the top of the dialog. This will allow you to type in
the map title text box.

3. Enter the map name in the map title text box as shown in Figure 6.12.

4. Click on the OK button
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Figure 6.13: Program window with title and legend hidden.
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6.6.2 Legend

Displaying the legend

To display the map legend:

1. Open the Format map dialog box by selecting Format from the Map menu.

2. Check the Legend checkbox (located towards the bottom of the dialog) shown in Fig-
ure 6.12.

3. Click on the OK button

Hiding the legend

Hiding the map legend will provide a greater area for displaying the map, as shown in Fig-
ure 6.13.

To hide the map legend:

1. Open the Format map dialog box by selecting Format from the Map menu.

2. Un-check the Legend checkbox.

3. Click on the OK button

6.6.3 North arrow

Displaying the north arrow

Figure 6.14: North arrow

To display the north arrow (shown in Figure 6.14):

1. Open the Format map dialog box by selecting Format from the Map menu.

2. Check the North arrow checkbox at the bottom of the dialog (shown in Figure 6.12).

3. Click on the OK button
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Hiding the north arrow

To hide the north arrow:

1. Open the Format map dialog box by selecting Format from the Map menu.

2. Un-check the North arrow checkbox.

3. Click on the OK button
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Outputs

7.1 Saving site data

If you change the location of a site in your map, you have the option of saving the updated
coordinates of the site(s) to a CSV file.

To save your changed site location, select Save from the file menu as shown in Figure 7.1.

This will open up the Save As dialog, shown in Figure 7.2. Enter the name you would like
the file saved as - in this example the file with the updated site coordinates will be called
100x100sites latlong modified.csv.

7.2 Printing

There are three different ways you can choose to print a map - as a layout or as a plain map
either printed to scale or to fit the page. These are explained in the following sections.

In each case, you must set up the printer before you open the print dialog. Once you have
opened the print dialog, you will be able to see which printer is selected but you will not be
able to change the printer selection or set printer options from this window.

7.2.1 Print to fit page

To print your map to fit the page, start by opening the Print dialog from the File menu as
shown in Figure 7.3

In the print dialog, select to Page, and click the Print button to send your map to the
printer.

Figure 7.5 shows an example output when printing to page.
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7.2 Printing

Figure 7.1: Opening the Save Site File dialog.

Figure 7.2: Save Site File dialog.
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Figure 7.3: Opening the Print dialog
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7.2 Printing

Figure 7.4: Print dialog with “print to page” selected.

7.2.2 Print to scale

You can also choose to print your map to scale. To do this, open the print dialog as before
an select the to Scale printing option. In the text input box, type in the scale you want your
map printed at. In the example shown in Figure 7.6 1570000 has been entered in the text box,
so the map will be printed at a scale of 1 : 1570000.

When you select the Print button you will be shown details about the map scale you have
chosen, including the dimensions of the page and the dimensions of the map. Check that
your map will fit onto the selected paper size, and select the Yes button to print the map.
Figure 7.8 shows an example output when printing to scale.

7.2.3 Print to layout

If you want, you can print a map layout instead of printing a plain map. A map layout contains
the map, a legend, a north arrow, a title, a scalebar and details about the map extent.

To print a layout, select as a map layout on the Print dialog (Figure 7.9) and click on the
OK button.

You will then be shown a preview of your print layout. In future versions of the AUSRIVAS
Mapping software you will be able to alter the layout by dragging the different map components
in the preview, which is why the preview stage of printing as a layout exists. At the moment
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Figure 7.5: Map printed with Print to Page printing option.
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7.2 Printing

Figure 7.6: Print dialog with “print to scale” selected.

Figure 7.7: Print to Scale confirmation dialog.
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Figure 7.8: Map printed with Print to Scale printing option.
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7.2 Printing

Figure 7.9: Print dialog with “print as a map layout” selected.

though, your only option is to select whether to print the map layout or to cancel. The print
preview window is shown in Figure 7.10. The print preview is a rough mock-up of the final
layout, so the quality of the preview is not as high as you will get in your printed version.
Figure 7.11 shows an example output when printing as a layout.
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Figure 7.10: Print layout preview.
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7.2 Printing

Figure 7.11: Map printed with Print as Layout printing option.
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Finishing up

8.1 Preparing to load a new data set

To reset map data, pending requesting a new map, loading a new data site data set or exiting
the program, use the Close function in the File menu (Figure 8.1)

Figure 8.1: Closing a file
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8.2 Exiting the program

This will leave you with a “clean” environment, as shown in Figure 8.2, in which to load a new
site data set or exit the program.

Figure 8.2: Program window after closing the site file.

Alternatively, you can request a new map or open a new site data set at any time and the
program will “clean up” for you before loading the new site data or map.

8.2 Exiting the program

To exit the program, select Exit from the File menu.
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Glossary

Catchment The areas of land that contributes surface water to the river.

AMG Australian Map Grid - a Cartesian coordinate system based on the Universal Transverse
Mercator projection. The unit of measure is the metre.

Coordinates Linear or angular quantities which designate the position of a point in a given
reference or grid system.

Coordinates, geographic A system of spherical coordinates for describing the positions of
points on the earth. The declinations and polar bearings in this system are the latitudes
and longitudes respectively.

Datum A mathematical surface on which a mapping and coordinate system is based.

GEODATA products comprise Geoscience Australia map information converted into digi-
tal format. Used in conjunction with geographic information systems GEODATA prod-
ucts assist applications such as resource management, environmental assessment, mineral
prospecting, communications and transportation planning.

Geodetic datum’s Establish the reference systems that describe the size and shape of the
earth, for example World Geodetic System 1984 (WGS-84).

Geographic reference system The Geographic Reference System consists of latitude and
longitude. This system treats the globe as if it were a sphere or spheroid. The sphere is
divided into 360 equal parts called degrees. Each degree can be further subdivided into
60 minutes, each composed of 60 seconds. The standard origin is where the Greenwich
Prime Meridian meets the Equator. All points north of the Equator and east of the Prime
Meridian are positive. The origin divides the globe into four quadrants: northwest,
northeast, southwest and southeast. Each line of longitude runs north and south and
measures the number of degrees east or west of the Prime Meridian. Values range from
positive 180 to negative 180 degrees. Lines of latitude run from east to west and measure
the number of degrees north or south of the Equator. Values range from the North Pole,
at positive 90 degrees, to the South Pole which is located at negative 90 degrees.

Lambert Conformal Conic Projection A method for converting Latitude and Longitude
onto a flat surface by projecting onto a cone whose axis is parallel to the axis of the earth
and which intersects the earth at two parallels.
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Latitude An angular measurement involving north-south angular displacements from the
equator. The Equator is at 0, the North Pole is at +90 and the South Pole is at -90
degrees.

Longitude An angular measurement involving east-west angular displacements from some
starting place. Most commonly, Greenwich, England serves as the starting point and is
considered to have a longitude of 0 degrees. Longitudes east of Greenwich are positive
numbers. Longitudes west of Greenwich are negative numbers. +180 and -180 Longitude
are the same meridian.

Map A representation of the earth’s surface. A cadastral map is one showing the land sub-
divided into units of ownership; a topographic map is one showing the physical and
superficial features as they appear on the ground; a thematic map displays a particular
theme, such as vegetation or population density.

Projected reference system In order to display the curved surface of the Earth on a flat
surface a number of projections have been developed, each with particular advantages
and disadvantages. Two common projections are the Universal Transverse Mercator and
the Lambert Conformal Conic.

Raster Image A cellular data structure composed of rows and columns. Each cell has a value
that represents an attribute value for the feature represented by that group of cells.

Vector data Spatial data in which the location of features is defined by points and straight
lines (vectors). A road network would be described by vector data.

WGS84 World Geodetic System 1984 - a geocentric geodetic datum used for the determination
of geographical coordinates developed by the United States Department of Defence. For
all practical purposes, the current standard Australian datum, GDA94, approximates to
WGS84.
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Technical details

11.1 Registry settings

Key:

HKEY CURRENT USER\Software\VB and VBA Program Setting\AUSRIVAS Mapping\Settings

Values:

Table 11.1: Registry values for key Settings.

Value name Value data
AUSRIVAS username User name
Proxy authentication required True or False
Proxy port Proxy server port number
Proxy required True or False
Proxy server Proxy server name
Proxy username Proxy authentication username
Temporary directory Path to writeable temp directory

Key:

HKEY CURRENT USER\Software\VB and VBA Program Setting\AUSRIVAS Mapping\System

Values:

Table 11.2: Registry values for key Settings.

Value name Value data
Program version Program version number
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11.2 Default values

Internet

Table 11.3: Default values for internet settings.

Setting Default value
Proxy required False
Proxy port 80
Proxy authentication required False
Client timeout 240 minutes
Server timeout 60 minutes
Number of concurrent users (server) 1

General

Table 11.4: Default values for general settings.

Setting Default value
Temporary directory C:\temp

11.3 Format of site file

Table 11.5: Format of site file.

Column 1 Column 2 Column 3 Column 4 ... Column n
Row 1 LOCATION C LATITUDE LONGITUDE Field 4 Field n
Row 2 Sitecode 1 Latitude 1 Longitude 1 Site 1 Field 4 Site 1 Field n
Row 3 Sitecode 2 Latitude 2 Longitude 2 Site 2 Field 4 Site 2 Field n
...
Row m Sitecode m Latitude m Longitude m Site m Field m Site m Field n
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11.3 Format of site file

Table 11.6: Example site file

LOCATION C,LATITUDE, LONGITUDE, SITETYPE, O E TAXA,TAXA BAND
s4102001, -35.3291596, 148.9473896, Reference, 0.96, A
s4102002, -35.3220563, 148.9406193, Reference, 0.88, A
s4102003, -35.3481086, 148.8895263, Reference, 0.95, A
s4102005, -35.4174656, 148.8349786, Reference, 1.11, A
s4102006, -35.6123930, 148.8217576, Reference, 1.18, X
s4102007, -35.3423032, 148.9146972, Reference, 0.97, A
s4102008, -35.3223664, 148.8636270, Test, 0.81, B
s4102009, -35.3605884, 148.8402936, Test, 0.80, B
s4102010, -35.3678742, 148.9505206, Test, 0.76, C
s4102012, -35.4155286, 148.9582763, Test, 0.67, D
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